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WARNING 

This application must not be used for real flight planning, aviation or navigation 

purposes.  

All calculations performed by this application are based on navigation data from 

Aerosoft or Navigraph provided in X-Plane (v.2) or with the Application (v.1). 

This application may contain bugs and may not perform as expected or 

promptly at all times.  

The developer of the application declines any responsibility that may be caused 

by any use of the application under any circumstances other than X-Plane flight 

simulation. 
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Preamble	

Boeing 737-300 is a simulation plane model developed by IXEG specifically for X-Plane. 

iGoDispatch Boeing-733 (hereinafter referred to as the Application) is a desktop application 

that helps you create a flight plan; estimate the required amount of fuel for your flight; load the 

plane with passengers, cargo and fuel; calculate various plane parameters, such as %MAC and 

Center of Gravity offset; track the flight on a map; dynamically adjust some of the plane’s 

parameters (e.g. the current Center of Gravity); and monitor your flight performance. It also 

includes inflight public announcements in several languages. 

IMPORTANT!  In order to perform certain functions, the application 

must be connected to X-Plane over the TCP protocol using the 

iGoConnect plug-in. Visit the following webpage to download the 

latest plug-in, read all documentation, and find a link to the support 

page:  

http://igoapp.ca/page_igoconnect/igoconnect.html. 

For this tutorial, we will create a flight plan from Toronto Pearson International Airport to 

Miami International Airport with an alternate airport in Fort Lauderdale.  

Our flight plan will be as follows: 

CYYZ BETES1 AIRRA Q103 PSK CAE J51 SAV J103 OMN HILEY6 KMIA  

 

  

http://igoapp.ca/page_igoconnect/igoconnect.html
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iGoConnect		

iGoConnect is a plugin for X-Plane flight simulator. iGoConnect (hereinafter referred to as the 

Plugin) acts as a server that connects X-Plane to iGoDispatch using the TCP protocol. The Plugin 

performs the following actions:  

• Searches navdata provided with X-Plane or the Application for specific airports and 

waypoints and sends it to the Application to create a flightplan. 

• Adjusts loading parameters (e.g., Center of Gravity offset, payload weight, and fuel 

weight) of the plane by changing the relevant datarefs in X-Plane based on calculations 

performed in the Application. 

• Communicates to the Application a number of X-Plane datarefs (ACARS data), such as 

the plane’s position (latitude and longitude); heading (true and magnetic); weight; 

available fuel; current fuel flow; ground speed; and altitude. In return, the Application 

dynamically adjusts the current plane’s CG offset during the flight resulting in greater 

flight realism (X-Plane 11 only; in X-Plane 12, CG is adjusted automatically whenever 

weights are changed). 

• The Plugin monitors the main flight parameters, such as G-force, turbulence, maximum 

speeds, lights, flaps, gear, etc., and determines if any of them have been violated or 

exceeded. It then creates a Flight Performance Report, which can be later displayed in 

the Application. 

Install	iGoConnect	Plug-in	

The Plugin is a so-called fat plugin, i.e. it includes all necessary files inside one folder called 

iGoConnect. In order to install the Plugin, do the following: 

1. Download the file iGoConnect_vX.X.zip from either website: 

• http://igoapp.ca/page_igoconnect/igoconnect.html   

• http://forums.x-pilot.com/files/file/707-igoconnect/ 
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2. Unzip and move the iGoConnect folder to the following location: 

• Your X-Plane folder\Resources\plugins\ 

 

3. Make sure the Plugin folder includes the following subfolders: 

• 32 – contains the 32-bit plugin files for Windows and Linux (for older versions of X-

Plane);  

• 64 – contains the 64-bit plugin files for Windows and Linux; 

• mac.xpl – plugin for Mac (Intel and Silicon); 

• Configuration – contains the following configuration files:  

o preferences.cfg – stores the value of IP Port and other information; 

o planedata.cfg – stores plane technical characteristics used to monitor the flight 

performance, such as Vmo|Mmo, Flaps limitation speeds, VLE,VLOE, VLOR, 

Maximum Ramp Weight, Maximum Takeoff Weight, Maximum Landing Weight; 

• Docs – contains License Terms, Manual, and other documents, if available; 

• navdata – contains a navigation dataset from Aerosoft or Navigraph (Plugin version 2.X 

only); and 
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• Report – contains performance files that are passed to the Application to create a 

performance report. 

How	it	works	

The interface of the Plugin is extremely easy. In fact, you do not need to do anything. By 

default, both the Plugin and the Application have the same Port – 7767. You only need to 

modify its settings if, for some reason, you want another port assigned to the TCP connection.  

In this case, go to the Plugins tab in X-Plane, select iGoConnect and in the opened TCP Settings 

window type the new TCP Port. Click on Set and restart X-Plane. Do not forget to change the 

Port value in the Application.  

 

 
IMPORTANT! 

If you have problems connecting the iGoDispatch application to the computer 

with X-Plane running, refer to Section “Troubleshooting Your Connection 

Problem”. 
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Update	Navdata	

The Plugin version 2.X and below uses navdata provided by Aerosoft (data by Navigraph is 

also compatible), whereas version 3.X and higher is linked directly to navdata in X-Plane. 

Before updating navdata, verify which version of the Plugin you have.  

Version	3.X	

The Plugin version 3.X and higher uses default or custom data provided with X-Plane. Refer to 

the Aerosoft and Navigraph guides on how to update their navdata for the simulator. 

Version	2.X	

The Plugin comes with the default navdata from Aerosoft. The navdata is needed for the iOS 

version of the application only. Version 2 of the Plugin is not compatible with version 2 of the 

Application, which uses its own navdata (see Section “iGoDispatch. Update Navdata” for more 

details).  

Updating	Aerosoft	navdata	
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1. Open the NavDataPro application; 

2. In the X-Plane, find iGoDispatch (X-Plane). 

3. Change the path to point to the location where the iGoConnect plugin is located. 

4. Check the Select box and click on the Update icon. 

5. Click on Download to download and install the updated navdata. 

Updating	Navigraph	navdata	

 

1. Login to http://www.navigraph.com; 

2. Go to Products -> FMS Data -> Manual Install; 

3. Find FMS data for “X-Plane GNS430, 777 Worldliner (Ext/Prof), Flightfactor B757 

Professional, VMAX B767-300ER Professional, X-Crafts Embraer E-175 - native**” 

4. Click Download. 

5. Unzip the downloaded file. 

6. Copy the folder “navdata” in the unzipped file and paste it in  

[X-Plane 10 folder]/Resources/ plugins/iGoConnect/.  

Replace the folder when prompted. 
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iGoDispatch	

Installation	

On Windows, download the installation file (iGoDispatchBoeing733.exe) to any location of your 

hard drive. Launch the file and follow the instructions. By default, the application and other 

sub-folders will be installed in the following directory: C:\Program Files 

(x86)\iGoDispatchBoeing733\. 

On OS X, download the installation file (iGoDispatchBoeing733.dmg) to any location of your 

hard drive. Launch the file and follow the instructions. By default, the application will be 

installed in the following directory: Macintosh HD\Applications\iGoDispatchBoeing733. 

Other sub-folders are installed in the following directory: Macintosh HD\ Library\ 

iGoDispatchBoeing733\. 

IMPORTANT! 

Java Runtime Environment is required to use the Application (version 8 or higher). 

The Java library is already included with the OS X installation file, so it is not 

necessary to install Java if you use a Mac computer. The Windows version of the 

application does not include the Java library, so make sure you have the latest 

version of Java installed on your computer to run the Application. 

The Application includes the following sub-folders and files: 

• config – includes the following files: 

o cfg.xml: this file is created when the Application is launched for the first time. It 

includes any changes you make in the Application’s settings. 

o LogIGD.txt: this file is created every time the Application is launched. This is a 

log that lists all activities performed by the user. This is a useful tool that allows 

debugging the Application if you have any problems with it.  
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• flightplans –  includes all flightplans created and saved by the user using the 

Application. 

• license – includes license information for the Application and third-party libraries. 

• navdata – contains a navigation dataset from Aerosoft or Navigraph. IMPORTANT: This 

folder is not included with version 2.X of the Application since it uses navdata 
provided with X-Plane.   

Update	Navdata	(ONLY	version	1.X)	

It is recommended to update the navigation dataset either using navdata from Aerosoft or 

Navigraph. 

Updating	Aerosoft	navdata	

 

1. Open the NavDataPro application; 

2. In the X-Plane 10 tab, find iGoDispatch (X-Plane). 

3. Change the path to point to the location where the iGoConnect plugin is located. 
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4. Check the Select box and click on the Update icon. 

5. Click on Download to download and install the updated navdata. 

6. Copy the content of the “navdata” folder and paste it into: 

• Windows: C:\Program Files (x86)\iGoDispatchBoeing733\navdata\. 

• Mac: Macintosh HD\Library\iGoDispatchBoeing733\navdata\. 

Updating	Navigraph	navdata	

 

1. Login to http://www.navigraph.com; 

2. Go to Products -> FMS Data -> Manual Install; 

3. Find FMS data for “X-Plane GNS430, FF757/767/777, X-Crafts Embraer E-175, 

Aerobask SkyView, JRollon Planes CRJ200, JARDesign A320/A330, ToLiss A319 
(XP10), STMA Aircraft - native” 

4. Click Download. 

5. Unzip the downloaded file. 

6. Copy the folder “navdata” in the unzipped file. Go to the following directories: 

• Windows: C:\Program Files (x86)\iGoDispatchBoeing733\. 

• Mac: Macintosh HD\Library\iGoDispatchBoeing733\. 

Paste the new folder and replace the old one when prompted. 
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Version 2 of the Application uses navdata provided with X-Plane. Refer to the Aerosoft and 

Navigraph guides on how to update their navdata for the simulator. 

Set	your	IP	Address	and	Port	

Certain functions of the Application require that TCP connection be established via Wi-Fi with X-

Plane through the iGoConnect plugin. Always make sure that the latest version of the Plugin is 

installed in X-Plane. 

First, identify the IP address of the computer where X-Plane is installed. Refer to PC, Mac or 

Linux documentation to learn how the IP address can be identified. Enter the IP address in the 

textboxes. 

Open the Settings panel of the Application. 
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For the TCP connection to be established, you also need to identify the Port number. The 

default port number for the Application is 7767 (displayed on the Application as “AUTO”). If any 

of your other programs already use this port, you may change it. If you change the port, make 

sure that the same port number is set in both the Application and the Plugin. Changing the port 

in X-Plane requires restarting the simulator. 

Other	Settings	

The Application includes an option to have inflight public announcements during the flight. To 

enable the option, click on the Inflight PA ON radio button. Enabling or disabling public 

announcements requires restart of the Application.  

You may also select the language of the announcements using the Language drop-down list. It 

is possible to change languages during the flight.  

IMPORTANT! The ACARS connection with X-Plane is required for the inflight public 

announcements to work. If the Application is disconnected from the simulator, 

the announcements will be disabled even if the switch remains in the ON position. 

Refer to section “ACARS” regarding establishing the connection. 

You may also select the Units of Measurement displayed in the Application by selecting Metric 

or Imperial units using the Units radio buttons. 

Other settings include the Application background color (dark by default) and the loading 

mode. Select the Instant radio button to load passengers and fuel instantly and the Real time 

radio button to enable loading passengers and fuel in real time. Depending on the number of 

passengers and the amount of fuel to be loaded, it may take approximately 30 minutes for 

payload and 20 minutes for fuel.  

The Settings panel also contains links to support information for the Application, as well as the 

Terms and Conditions.  
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Enter	Your	Flightplan	

IMPORTANT! Version 2 of the Application uses X-Plane navdata. To be able to 

enter or edit a flightplan in the Application, you MUST be able to connect to X-

Plane through the iGoConnect Plugin. Open X-Plane, load the plane, make sure 

the Settings screen of the simulator is closed. Follow the procedures below. If you 

have problems with connecting to X-Plane, refer to Section “Troubleshooting Your 

Connection Problem”. 

There are multiple ways to enter a flightplan in the Application. You may enter it yourself using 

the Departure, Destination, Alternation, and Waypoints panels. You may also copy and paste 

the flightplan from other sources, such as a text file or a website. Or you may save your 

flightplan on the hard drive of your computer and then open it later. 

Enter	a	new	flightplan	

Open the Departure Airport panel by clicking on button  . Enter the ICAO code of the 

airport in the textfield (e.g., CYYZ) and press button  . Once the airport navdata is 

downloaded, you may select the departure runway and SID based on the current METAR 

information from the National Oceanic and Atmospheric Administration website 

(www.noaa.gov). METAR may be downloaded by pressing the Download METAR button.  

The individual panels for each airport will display the temperature, current winds information, 

indicated and pressure elevations, and wind component.  

 

http://www.noaa.gov/
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Do the same for the Arrival (button  ) and Alternate (button  ) airports (optional). 

Waypoints and airways can be entered in the corresponding textboxes on the Waypoints and 

Distance panel. Go to the panel by clicking on button  . It is not mandatory to enter an 

airway. If your next waypoint is a direct leg to the next waypoint, leave the airway textbox 

blank. Do not write “DIRECT”. However, when you have an airway, you must include the 

destination (transition) waypoint within your airway. If the waypoint is not identified as part of 

the airway, the airway will be not be added to the flight plan. Once you entered your waypoint 

and an airway, if required, press button  . 
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IMPORTANT! If a waypoint is already included in the SID procedures, you do not 

have to enter it again as a new waypoint. However, in this case, this waypoint is 

identified as part of SID and therefore will not be included in the fpl file needed to 

load co-routes in the plane FMC (co-routes cannot include SIDs, STARs, and 

Approach procedures). Moreover, fpl files do not allow having an airway 

immediately follow the departure airport. Otherwise, the flight plan cannot be 

loaded. In the above case, not including AIRRA as an additional waypoint after 

BETES1 SID with a transition point AIRRA will result in dropping both waypoint 

AIRRA and airway Q103 (i.e., the flight plan will be as follows: “CYYZ PSK KMIA”). 

Therefore, if you plan to use co-routes on FMC it is recommended that you add 

AIRRA even if you have this waypoint as part of the SID. 
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If the original and final waypoints within the same airway are located next to each 

other (no other waypoints in between), the application currently removes the 

airway name and treats it as a DIRECT leg from one waypoint to another. This may 

be revised in future releases. 

If navdata includes more than one waypoint with the same name, a list containing all of these 

waypoints will be displayed so that the required waypoint can be selected. The waypoint 

closest to the last point in the flight plan will be displayed first and pre-selected. 

Paste	a	flightplan	from	other	sources	

The flightplan can be copied from another source, such as a text file, website, etc. Copy the 

original text with a plan, select the text area at the bottom of the Waypoints and Distance 

panel, hit Ctrl+V to paste the plan, and press button  to upload it to the application.  
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The text pasted into the text area is not case sensitive. Depending on the complexity of the 

plan, it may take several seconds to complete uploading. 

IMPORTANT! When the flightplan is pasted into the application, SIDs and STARs will 

be ignored. Add them manually using the airport panels. 

Save	and	open	a	flightplan	from	the	hard	drive	

A completed flightplan can be saved to your hard drive and loaded later. The plans will be saved 

in the following directories: 

• Windows: C:\Program Files (x86)\iGoDispatchBoeing733\flightplans\. 

• Mac: Macintosh HD\Library\iGoDispatchBoeing733\flightplans\. 

To save a flightplan, press button  . To load a flightplan from the hard drive, press button 

 and select the required file from a list of saved plans. 

IMPORTANT! When the flightplan is loaded from your hard drive, SIDs and STARs will 

be ignored. Add them manually using the airport panels.  

IMPORTANT! Application version 2.X only: Loading the flightplan from your hard 

drive still requires that the Application is connected to X-Plane through the 

iGoConnect Plugin. Make sure that the simulator is open before loading the 

flightplan. 

Edit	or	delete	the	flightplan	

Once completed, the flightplan can be edited or completely deleted. In order to delete a 

particular waypoint in the flightplan (with the exception of the Departure, Arrival or Alternate 

airports), select the waypoint and press button  .  

To delete the whole flightplan, press button  and confirm deletion. 
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Once the flight plan has been deleted, all related information including the route and METAR 

will be permanently removed. 

Winds	Aloft	

Go to the Winds Aloft panel by pressing button  . There are three ways to set winds aloft 

data in the application: the data may be downloaded from the National Oceanic and 

Atmospheric Administration (NOAA) servers; the data may be downloaded from X-Plane (useful 

when custom winds are set in the simulator); and the data may be manually edited in the 

Application for each waypoint in the flightplan.  

 

Press button Download from NOAA to download the current winds and temperatures 

information from the NOAA servers. The information is downloaded for three altitudes: 10000 

feet, 21000 feet, and 34000 feet. Temperature, winds speed and direction are then 
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interpolated for each waypoint in the flightplan based on its altitude. If the plan has been 

modified (for example, a new waypoint or an alternate airport has been added), the winds data 

will be erased; it must then be downloaded again. Therefore, it is recommended to download 

the winds aloft information once your flightplan has been finalized. Once winds aloft data have 

been downloaded, the application will also display date and time when these data were 

acquired. 

In order to download the current winds information from X-Plane, press button Download 

from X-Plane. Similar to the data downloaded from the NOAA servers, winds information from 

X-Plane is also interpolated for each waypoint in the flightplan based on the settings in the 

simulator. Wind direction and speed, as well as the altitude level can be modified directly in X-

Plane.  

IMPORTANT! X-Plane 11 data does not include temperatures at the selected 

altitude; therefore, the ISA Dev will not be calculated in this case. X-Plane 12 will 

include temperatures and the ISA Dev information. 

Wind direction, speed, and temperature can also be manually edited for each waypoint in the 

flightplan. The edited information will be applied only to the selected waypoint. 

Downloading winds aloft data results in determining the air distance where wind component 

for each leg of your trip is taken into account. The air distance will be used to calculate the 

required trip fuel and time. If neither wind direction nor speed is entered, the air distance will 

equal the ground distance.  
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Printing	a	Flight	Plan	as	a	PDF	file	

The flightplan can be printed as a PDF file. 

Once all flight information has been entered in the application, press button   in the 

Flightplan panel. After that, you may also add maps to the PDF file. To do so, go to the ACARS 

panel and press the same button. It is possible to add as many maps as you want. It is 

important to save a flightplan as a PDF file prior to adding a map image. Otherwise, a warning 

message will be displayed prompting to save the plan first. 

In order to open the PDF file and/or print it, select Print Flightplan in the Menu bar. 

Alternatively, the file can be opened from the File Explorer/Finder. The file is located in the 

flightplans folder of the application (see section Installation for more details). 
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Parsing	Flight	Plan	to	FMC	

The entered flight plan can be parsed to the plane’s co-route folder (through the Wi-Fi 

connection), saved as an fpl file, and then uploaded on your FMC. 

IMPORTANT! Both iGoConnect plug-in and the Boeing-733 plane must have 

navdata from the same publisher (Navigraph or Aerosoft) and of the same AIRAC 

cycle. Failure to do so may result in missing airports and waypoints and inability to 

load the flight plan on your FMC. 

Press button  to parse the flight plan to X-Plane. Once the flight plan is parsed to your X-

Plane folder, a notification message will be displayed in the Application. 
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Go to the FMC, click on the RTE button, and type the file name as follows: [ICAO code for 

departure][ICAO code for destination] (no spaces).  

 

A file with the same name was to be saved in the coroute folder of your plane. If the file is 

found and does not contain any errors, the co-route is loaded and can be activated. 

IMPORTANT! Make sure that the root folder of the plane has folder “coroute”, 

otherwise parsing the flightplan to FMS will fail. 
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Loading	Plane	

The Load panel allows you to select your Flight Level, as well as ground APU and taxi time. It 

also lets you select whether APU will be used during cruise, whether you are constrained by the 

250 knots speed limitation below the altitude of 10000 feet, which A/C pack regime will be used 

during flight, and whether wing or engine A/I systems will be operational. All of this will have an 

impact on the amount of fuel required for your trip. 

IMPORTANT! The most recent version of iGoConnect must be installed in X-Plane to 

correctly load passengers, cargo, and fuel via the Network.  
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The tab also displays detailed information about your weights (empty, payload, zero fuel 

weight, ramp weight, as well as estimated take-off and landing weights), flight time, and center 

of gravity. 

Load	Passengers	and	Cargo	

Go to the Pax and Cargo Loading panel by pressing button  . Use sliders for each of the 

passenger or cargo zone to select your payload. As a passenger zone slider is being moved, the 

application randomly selects categories of passengers seated in each zone. When you load the 

plane with passengers, the cargo compartments are also automatically adjusted – the weight of 

luggage is added and evenly distributed between the two compartments. You may increase or 

reduce the cargo weight by dragging the slider representing each of the cargo compartments.  
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The application displays the number of passengers and their weights in each of the five (version 

1.x – three) passenger zones, the total cargo weight, empty weight, total payload weight, and 

zero fuel weight.  

The panel also displays the estimated Take-off MAC% which is automatically adjusted while you 

load passengers or cargo. If the estimated MAC% is outside of allowed limits, it becomes 

highlighted in red. 

To load passengers and cargo in X-Plane, press button  . Loading can be done instantly or 

in real time. Select the loading mode in the Settings panel. 

Load	Fuel	

The application estimates the required fuel taking into account the following: 
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• Fuel required for taxi and ground APU;  

• Trip burn fuel – fuel required for flying from Departure to Destination;  

• Contingency fuel – usually 5% of the trip burn fuel;  

• Final reserve fuel;  

• Fuel required for flying from Departure to Alternate.  

• Additional fuel (APU during cruise, A/C packs, A/I, and 250 knots limitation) 

Select how much fuel you would like to load by moving either the left, right or center slider 

representing fuel tanks. Changing any of the wing sliders automatically adjusts the other wing 

slider. Alternatively, fuel may also be loaded manually. Enter the amount of fuel in the 

corresponding textboxes.   
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Amount of fuel impacts the center of gravity of the plane. As in the case with loading 

passengers, the Application estimates the take-off MAC% with the current fuel load. Loading 

fuel can also be done instantly or in real time. Select the loading mode in the Settings panel. 

IMPORTANT! Fuel can only be loaded by the Application when the plane is cold 

and dark (APU and engines are not running). Otherwise, the fuel weight will not 

be adjusted in X-Plane. 

ACARS	

The ACARS panel displays the current flight information and tracks the position of your plane 

on the map.  The most recent version of iGoConnect must be installed in X-Plane for correct 

sharing of data between the Application and the simulator.   

IMPORTANT! By default, the Application is not connected to X-Plane. When you 

upload the flight plan to FMC, download winds aloft data or pass the weight and 

CG information to the simulator, a temporary connection is established only for 

the duration required for sharing the data between the server and the client. In 

order to receive the ACARS data on the panel, the permanent connection with X-

Plane must be set by pressing the connection toggle button. 

Press button  to turn on ACARS. Once the connection with X-Plane is established, the 

button will change to  . The following data will be displayed on the Application panel:  

• Current position of the airplane (latitude and longitude);  

• Heading (true heading is used to display the plane image on the map and the magnetic 

heading is displayed for your information);  

• Current total plane weight (in pounds and kilograms);  

• Fuel weight and flow (in pounds and kilograms per hour);  

• Ground speed (in knots);  

• Remaining time and distance at the current fuel flow;  
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• Current altitude (in feet);  

• Current %MAC and CG offset; and 

• Optimal Altitude for the current weight. 

 

The CG data (%MAC and offset) are dynamic values, i.e., they are constantly changing during 

the flight as the center of gravity is dependent on the weight of fuel. The application re-

calculates the current CG offset and dynamically adjusts this value in X-Plane, which results in 

more flight realism.  

The panel includes the following additional functions for manipulation with the map: 

 — Zoom in the map; 
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 — Zoom out the map; 

 — Center the map to the current flightplan; 

 — Turn on map annotations showing the names of flightplan waypoints. When ACARS is 

on, annotations will appear at the time of the next data exchange between the 

server and the client, which may take a few seconds. 

Procedures	

The Procedures panel presents a pre-takeoff checklist and enables the pilot to follow the 

completed procedures identified by a check mark. The check marks will only be displayed in 

the panel if the plane has started in the Cold and Dark mode. Otherwise, the panel will show 

the current status of each of the checklist items, but the check marks will not be displayed. 

IMPORTANT! To follow procedures, the ACARS connection must be ON. 

Otherwise, a warning will inform that no connection is available. The checklist is 

refreshed when a TCP message arrives from the server. Therefore, the completed 

procedure items may be check marked with a delay. If you wish to reduce the 

delay, the Refresh Rate may be changed in the Settings Panel. 

It is not necessary to follow the exact order of the procedures in the list, although it is strongly 

recommended. The page will be scrolled down automatically once every item currently visible 

in the panel has been check marked. 

Once the plane took off, the status of the checklist items will change to “EN ROUTE”. 
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Flight	Performance	

The Performance panel allows you to assess your flight performance based on over 30 

parameters. Press button  to download the current performance report. The most recent 

version of iGoConnect must be installed in X-Plane.  

IMPORTANT! Download your performance report BEFORE resetting your flight or 

closing X-Plane. As soon as the flight has been reset (e.g., a new plane has been 

loaded after your flight) or you have closed X-Plane, the performance report will 

be reset to a new flight and all data pertinent to the previous flight will be erased. 

The option to save the previous reports is not available at this time so your old report will be 

deleted.  
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Using the table on the left side of the panel, select the parameter you are interested in. The 

Application will display the relevant information, including any problems identified. The graph 

will show the time when the problem occurred. 

 

Have a safe flight! 
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TROUBLESHOOTING	YOUR	CONNECTION	PROBLEM	

If you cannot establish TCP connection with X-Plane via the iGoConnect plugin, try the following 

steps: 

1. Make sure that X-Plane is running when you try to establish connection. Your plane has to 

be loaded in X-Plane. 

2. Check the IP Address of your X-Plane computer. Make sure that this address is correctly 

entered on the Settings panel of the Application. 

3. Check the IP Address of your X-Plane computer again and whether it is correctly entered 

in the Application. This is not a typo. Ninety nine percent of all cases where a problem with 

connection is reported account for entering the wrong IP address. 

4. If you changed the port number on the application, do NOT forget to change it in the 

plugin. After the number has been changed, reload X-Plane. 

5. Once the IP Address and the Port number are checked, type an ICAO code (e.g., KLAX) in 

the Departure textfield on the Flightplan panel. Tap on button  to upload the airport 

information. Has the information been successfully uploaded? If yes, you have no problem 

with the connection – everything works as it should. 

6. If you still have problems connecting, you may have your firewall blocking the port and not 

allowing the Application to establish connection through it.  

• Start your X-Plane and wait till a plane finishes loading.  

• In Mac, open Terminal. In Windows, open Command Prompt window.  

• Type “telnet”, followed by the IP Address of the X-Plane computer (the one you need 

to enter in the Application), and the Port number. Do not use quotes, for example:  

telnet 192.168.1.99 7767 
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7. If the connection was not established, you probably use a firewall that blocks the port and 

the port must be opened. Disabling your firewall completely is not necessary and is not 

recommended. You may temporarily disable your firewall to confirm that it causes your 

connection problem. Once the port opening rule is set, the firewall can be turned on again.  

In order to open the IP Port using default Windows and Mac firewalls, the following can be 

done: 

For Windows: 

1) Go to Control Panel > Windows Firewall 

2) Click on "Advanced Settings" in the left-hand pane. 

3) Click on "Inbound Rules" and then "New rule". 

4) Select "Port", click next, select "TCP", and enter "7767" as the local port. 

5) Click next, and allow the connection. 

6) Click next again, and ensure that "Domain", "Private" and "Public" are all ticked. 

7) Name your firewall rule, e.g. "iGoConnect", and then save it. 

For Mac: 

1) Go to System Preferences, and choose the Security and Privacy Tab. 

2) Click on the Firewall Tab, and the Firewall options button.  

3) The page will show you the applications that are allowed access through your firewall 

4) Add new applications to the list by clicking on the plus icon. 

If you have third party firewalls, please refer to their manuals. 

8. If nothing worked: 

• Send me an email to igodispatch@igoapp.ca. Do not forget to attach file LogIGD.txt 

that can be found in: 

• Windows: C:\Program Files (x86)\iGoDispatchBoeing733\config\. 

• Mac: Macintosh HD\Library\iGoDispatchBoeing733\config\. 

We will fix it together! 

mailto:igodispatch@igoapp.ca

